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1.  INTRODUCTION

The BL2100 is a high-performance, C-programmable single-

board computer that offers built-in digital and analog I/O com-

bined with Ethernet connectivity in a compact form factor. A

Rabbit® 2000 microprocessor operating at 22.1 MHz provides

fast data processing. An optional plastic enclosure and

LCD/keypad module are available, and may be wall-mounted.

1.1  BL2100 Description

The BL2100 is an advanced single-board computer that incorporates the powerful Rabbit 

2000 microprocessor, flash memory, static RAM, digital I/O ports, A/D converter inputs, 

D/A converter outputs, RS-232/RS-485 serial ports, and a 10Base-T Ethernet port.

1.2  BL2100 Features

• Rabbit® 2000 microprocessor operating at 22.1 MHz.

• 128K static RAM and 256K flash memory standard, may be increased to 512K SRAM 

and 512K flash memory.

• 40 digital I/O: 24 protected digital inputs and 16 high-current digital outputs provide 

sinking and sourcing outputs.

• 15 analog channels: eleven 12-bit A/D converter inputs, four 12-bit D/A converter 0–10 V 

outputs (selected models).

• One RJ-45 Ethernet port compliant with IEEE 802.3 standard for 10Base-T Ethernet 

protocol (selected models).

• Two Ethernet status LEDs (selected models).

• Four serial ports (2 RS-232 or 1 RS-232 with RTS/CTS, 1 RS-485, and 1 CMOS-com-

patible programming port).

• Battery-backed real-time clock.

• Watchdog supervisor.

• Optional backlit 122 × 32 graphic display/keypad module.

• Remote program downloading and debugging capability via RabbitLink.

• Boards with the CE mark on their RabbitCore module are CE-compliant.
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Four BL2100 models are available. Their standard features are summarized in Table 1.

Additional 512K flash/512K SRAM memory options are available for custom orders 

involving nominal lead times. Contact your Rabbit sales representative or authorized 

distributor for more information.

Appendix A provides detailed specifications.

1.2.1  Connector Options

In addition to the standard screw-terminal connectors supplied on BL2100 boards, IDC 

headers, bottom-mount sockets, and polarized friction-lock terminals may be factory-

installed instead. Visit our Web site at www.rabbit.com or contact your Rabbit sales 

representative or authorized distributor for further information.

Table 1.  BL2100 Models

Feature BL2100 BL2110 BL2120 BL2130

Microprocessor Rabbit 2000 running at 22.1 MHz

Static RAM 128K

Flash Memory 256K

RJ-45 Ethernet Connector, 

Filter Capacitors, and LEDs
Yes No

A/D Converter Inputs

(-10 V to + 10 V)
Yes No Yes No

D/A Converter Outputs

(0 V to +10 V)
Yes No Yes No

RabbitCore Module Used RCM2200 RCM2300

Standard screw terminals, accept 

up to 14 AWG (1.5 mm2) wire
Bottom-mount socket, 0.1" pitch

IDC headers, 0.1" pitch
Polarized friction-lock terminals, 

0.1" pitch
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1.3  Optional Add-Ons

• Plastic enclosure (can be wall-mounted or 

panel-mounted) with LCD/keypad module that 

comprises a 122 × 32 LCD graphic display, 7-

key keypad, and seven LEDs. The plastic 

enclosure consists of a base and a cover for an 

assembly made up of the BL2100 with the 

LCD/keypad module plugged in.

• Plastic enclosure base.

•  LCD/keypad module.

One enclosure base is included with the Tool Kit.

Further details on these add-ons are provided in 

Appendix C and in Appendix D.

Visit our Web site for up-to-date information about additional add-ons and features as 

they become available. The Web site also has the latest revision of this user’s manual.
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1.4  Development and Evaluation Tools

1.4.1  Tool Kit

A Tool Kit contains the hardware essentials you will need to use your own BL2100 single-

board computer. The items in the Tool Kit and their use are as follows.

• BL2100 Getting Started instructions.

• Dynamic C CD-ROM, with complete product documentation on disk.

• Programming cable, used to connect your PC serial port to the BL2100.

• Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., U.K., 

and European style plugs).

• Demonstration Board with pushbutton switches and LEDs. The Demonstration Board 

can be hooked up to the BL2100 to demonstrate the I/O.

• Wire assembly to connect Demonstration Board to BL2100.

• Plastic enclosure base with mounting screws.

• Screwdriver.

• Rabbit 2000 Processor Easy Reference poster.

• Registration card.

Figure 1.  BL2100 Tool Kit
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1.4.2  Software

The BL2100 is programmed using version 7.06 or later of Rabbit’s Dynamic C. A compatible 

version is included on the Tool Kit CD-ROM. Dynamic C v. 9.60 includes the popular µC/OS-

II real-time operating system, point-to-point protocol (PPP), FAT file system, RabbitWeb, 

and other select libraries that were previously sold as individual Dynamic C modules.

Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure 

Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library. In addi-

tion to the Web-based technical support included at no extra charge, a one-year telephone-

based technical support subscription is also available for purchase. Visit our Web site at 

www.rabbit.com for further information and complete documentation, or contact your 

Rabbit sales representative or authorized distributor.

1.4.3  Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, use your browser to find and load default.htm in the docs 

folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our Web sites as well.



6 Smartcat (BL2100)

1.5  CE Compliance

Equipment is generally divided into two classes.

These limits apply over the range of 30–230 MHz. The limits are 7 dB higher for frequencies 

above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-based 

systems at frequencies above 300 MHz are generally well below background noise levels.

The BL2100 single-board computer has been tested and was found to 

be in conformity with the following applicable immunity and emission 

standards. The BL2110, BL2120, and BL2130 single-board computers 

are also CE qualified as they are sub-versions of the BL2100 single-

board computer. Boards that are CE-compliant have the CE mark.

Immunity

The BL2100 series of single-board computers meets the following EN55024/1998 immu-

nity standards.

• EN61000-4-3 (Radiated Immunity)

• EN61000-4-4 (EFT)

• EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.

Emissions

The BL2100 series of single-board computers meets the following emission standards with 

the Rabbit 2000 spectrum spreader turned on and set to the normal mode. The spectrum 

spreader is only available with Rev. C or higher of the Rabbit 2000 microprocessor. This 

microprocessor is used in all BL2100 series boards that carry the CE mark.

• EN55022:1998 Class A

• FCC Part 15 Class A 

NOTE: The BL2100 satisfied the Class A limits but not the Class B limits. Such equip-

ment need not be restricted in its sale, but the following warning must be included in 

the instructions for its use.

Additional shielding or filtering may be needed to meet Class B emissions standards.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:

less than 40 dB µV/m at 10 m

(40 dB relative to 1  µV/m) or 300 µV/m

More restrictive emissions requirement:

30 dB µV/m at 10 m or 100 µV/m

Warning

This is a Class A product. In a domestic environment this product may cause radio 

interference, in which case the user may be required to take adequate measures.
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1.5.1  Design Guidelines

Note the following requirements for incorporating a BL2100 series single-board computer 

into your application to comply with CE requirements.

General

• The power supply provided with the Tool Kit is for development purposes only. It is the 

customer’s responsibility to provide a CE-compliant power supply for the end-product 

application.

• When connecting the BL2100 single-board computer to outdoor cables, the customer is 

responsible for providing CE-approved surge/lighting protection.

• Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a 

metal conduit to assist in maintaining CE compliance and to conform to good cable 

design practices.

• When installing or servicing the BL2100, it is the responsibility of the end-user to use 

proper ESD precautions to prevent ESD damage to the BL2100. 

Safety

• All inputs and outputs to and from the BL2100 single-board computer must not be con-

nected to voltages exceeding SELV levels (42.4 V AC peak, or 60 V DC).

• The lithium backup battery circuit on the BL2100 single-board computer has been 

designed to protect the battery from hazardous conditions such as reverse charging and 

excessive current flows. Do not disable the safety features of the design.

1.5.2  Interfacing the BL2100 to Other Devices

There are two versions of the LCD/keypad module that may be used with the BL2100: a 

plug-in version (Part No. 101-0465), and a remote panel-mounted version with bezel (Part 

No. 101-0502). The BL2100 with the LCD/keypad module plugged in may be regarded as 

a “maintenance unit” that conforms to the same CE standards as does the BL2100 alone, 

where the entire assembly is mounted inside an enclosure, and the enclosure is only 

opened to “tune up” the system. In addition, the cable for a panel-mounted LCD/keypad 

module should be less than 30 cm (12") to maintain CE compliance. Appendix C provides 

complete information for mounting and using the LCD/keypad module.

Since the BL2100 single-board computers are designed to be connected to other devices, 

good EMC practices should be followed to ensure compliance. CE compliance is ulti-

mately the responsibility of the integrator. Additional information, tips, and technical 

assistance are available from your authorized Rabbit distributor, and are also available on 

our Web site at www.rabbit.com.
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2.  GETTING STARTED

Chapter 2 explains how to connect the programming cable and

power supply to the BL2100.

2.1  BL2100 Connections

1. Remove the RabbitCore module from the BL2100 main board, and set the module 

aside. The module is removed to allow access to the mounting holes on the main 

BL2100 board, and will be plugged back in to the main board later.

NOTE: If you are working with more than one BL2100 at a time, take care to keep the 

BL2100 main boards and their corresponding RabbitCore modules paired since the Rab-

bitCore modules store calibration constants specific to the BL2100 main board to which they 

are plugged in.

Figure 2.  Remove RabbitCore Module

from BL2100 Main Board
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2. Attach the BL2100 main board to the plastic enclosure base.

Position the BL2100 main board over the plastic enclosure base as shown below in 

Figure 3. Attach the BL2100 to the base using the four 4-40 × ¼ screws supplied with the 

enclosure base.

Figure 3.  Attach BL2100 Main Board to Plastic Enclosure Base

The plastic enclosure base facilitates handling the BL2100 during development, and pro-

vides an attractive mounting alternative. Alternatively, you may wish to use standoffs to 

protect the components on the other side of the board. The plastic enclosure base is offered 

as a separate option when individual BL2100 boards are purchased.

NOTE: Appendix D, “Plastic Enclosure,” provides additional information and specifications 

for the plastic enclosure.
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3. Reconnect the RabbitCore module to headers J16 and J17 on the BL2100 main board it 

was removed from earlier as shown in Figure 4. Be careful to align the pins over the 

headers, and do not bend them as you press down to mate the module with the BL2100 

main board.

NOTE: If you are working with more than one BL2100 at a time, take care to keep the 

BL2100 main boards and their corresponding RabbitCore modules paired since the Rab-

bitCore modules store calibration constants specific to the BL2100 main board to which they 

are plugged in.

Figure 4.  Reconnect RabbitCore Module

to BL2100 Main Board
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4. Connect the programming cable to download programs from your PC and to program 

and debug the BL2100.

Connect the 10-pin PROG connector of the programming cable to header J1 on the BL2100 

RabbitCore module. Ensure that the colored edge lines up with pin 1 as shown. (Do not use 

the DIAG connector, which is used for a nonprogramming serial connection.) Connect the 

other end of the programming cable to a COM port on your PC. Make a note of the port to 

which you connect the cable, as Dynamic C will need to have this parameter configured. 

Note that COM1 on the PC is the default COM port used by Dynamic C.

Figure 5.  Programming Cable Connections

NOTE: Never disconnect the programming cable by pulling on the ribbon cable. Carefully 

pull on the connector to remove it from the header.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use an 

RS-232/USB converter with the programming cable supplied with the Tool Kit. An RS-

232/USB converter (part number 20-151-0178) is available through the Web store. Note that 

not all RS-232/USB converters work with Dynamic C.
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5. Connect the power supply.

First, prepare the AC adapter for the country where it will be used by selecting the plug. 

The BL2100 Tool Kit presently includes Canada/Japan/U.S., Australia/N.Z., U.K., and 

European style plugs. Snap in the top of the plug assembly into the slot at the top of the 

AC adapter as shown in Figure 5, then press down on the spring-loaded clip below the 

plug assembly to allow the plug assembly to click into place.

Connect the bare ends of the power supply to the +RAW and GND positions on screw-

terminal header J5 (IDC header J4) as shown in Figure 6.

Figure 6.  Power Supply Connections

6. Apply power.

Plug in the AC adapter. If you are using your own power supply, it must provide 9 to 

36 V DC (13 to 36 V DC if you intend to use the full range of the D/A converter 

outputs)—voltages outside this range could damage the BL2100.

CAUTION: Unplug the power supply while you make or otherwise work with the connections 

to the headers. This will protect your BL2100 from inadvertent shorts or power spikes.

NOTE: A hardware RESET is done by unplugging the AC adapter, then plugging it back in.
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2.2  Installing Dynamic C

If you have not yet installed Dynamic C version 7.06 (or a later version), do so now by 

inserting the Dynamic C CD in your PC’s CD-ROM drive. The CD will auto-install unless 

you have disabled auto-install on your PC.

If the CD does not auto-install, click Start > Run from the Windows Start button and 

browse for the Dynamic C setup.exe file on your CD drive. Click OK to begin the 

installation once you have selected the setup.exe file.

The installation program will guide you through the installation process. Most steps of the 

process are self-explanatory.

Dynamic C uses a COM (serial) port to communicate with the target development system. 

The installation allows you to choose the COM port that will be used. The default selec-

tion is COM1. You may select any available port for Dynamic C’s use. If you are not cer-

tain which port is available, select COM1. This selection can be changed later within 

Dynamic C.

Once your installation is complete, you will have up to three icons on your PC desktop. 

One icon is for Dynamic C, one opens the documentation menu, and the third is for the 

Rabbit Field Utility, a tool used to download precompiled software to a target system.

If you have purchased the optional Dynamic C Rabbit Embedded Security Pack, install it 

after installing Dynamic C. You must install the Rabbit Embedded Security Pack in the 

same directory where Dynamic C was installed.

The Dynamic C User’s Manual provides detailed instructions for the installation of 

Dynamic C and any future upgrades.

NOTE: If you have an earlier version of Dynamic C already installed, the default installation 

of the later version will be in a different folder, and a separate icon will appear on your desk-

top.
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2.3  Starting Dynamic C

Once the BL2100 is connected to your PC and to a power source, start Dynamic C by double-

clicking on the Dynamic C icon on your desktop or in your Start menu.

If you are using a USB port to connect your computer to the BL2100, choose Options > 

Project Options and select “Use USB to Serial Converter” under the Communications 

tab. Click OK.

2.4  Run a Sample Program

Use the File menu to open the sample program PONG.C, which is in the Dynamic C 

SAMPLES folder. Press function key F9 to compile and run the program. The STDIO 

window will open on your PC and will display a small square bouncing around in a box.

This program shows that the CPU is working. The sample program described in 

Section 5.2.3, “Run the PINGME.C Demo,” tests the TCP/IP portion of the board.

2.4.1  Troubleshooting

If Dynamic C cannot find the target system (error message "No Rabbit Processor 

Detected."):

• Check that the BL2100 is powered correctly — the AC adapter should be plugged in to the 

+RAW and GND positions on screw-terminal header J5 (IDC header J4).

• Check both ends of the programming cable to ensure that they are firmly plugged into 

the PC and the PROG connector, not the DIAG connector, is plugged in to the program-

ming port on the RabbitCore module with the marked (colored) edge of the program-

ming cable towards pin 1 of the programming header.

• Ensure that the RabbitCore module is firmly and correctly installed in its connectors on 

the BL2100 main board.

• Dynamic C uses the COM port specified during installation. Select a different COM 

port within Dynamic C. From the Options menu, select Project Options, then select 

Communications. Select another COM port from the list, then click OK. Press 

<Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C still reports it is 

unable to locate the target system, repeat the above steps until you locate the COM port 

used by the programming cable.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-

cation error message when you compile and load a sample program, it is possible that your 

PC cannot handle the higher program-loading baud rate. Try changing the maximum 

download rate to a slower baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Communications 

menu. Select a slower Max download baud rate.
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If a program compiles and loads, but then loses target communication before you can 

begin debugging, it is possible that your PC cannot handle the default debugging baud 

rate. Try lowering the debugging baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Communications 

menu. Choose a lower debug baud rate.

2.5  Where Do I Go From Here?

If the sample program ran fine, you are now ready to go on to other sample programs and to 

develop your own applications. The source code for the sample programs is provided to allow 

you to modify them for your own use. The BL2100 User’s Manual also provides complete 

hardware reference information and describes the software function calls for the BL2100 and 

the optional LCD/keypad module.

For advanced development topics, refer to the Dynamic C User’s Manual and the 

Dynamic C TCP/IP User’s Manual, also in the online documentation set.

2.5.1  Technical Support

NOTE: If you purchased your BL2100 through a distributor or Rabbit partner, contact the 

distributor or partner first for technical support.

If there are any problems at this point:

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/ 

and at www.rabbit.com/forums/.

• Use the Technical Support e-mail form at www.rabbit.com/support/.

If the sample program ran fine, you are now ready to go on to explore other BL2100 fea-

tures and develop your own applications.

Chapter 3, “Subsystems,” provides a description of the BL2100’s features, Chapter 4, 

“Software,” describes the Dynamic C software libraries and introduces some sample pro-

grams, and Chapter 5, “Using the TCP/IP Features,” explains the TCP/IP features.
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3.  SUBSYSTEMS

Chapter 3 describes the principal subsystems for the BL2100.

•Digital I/O

•Serial Communication

•A/D Converter Inputs

•D/A Converter Outputs

•Analog Reference Voltage Circuit

•Memory

•External Interrupts

Figure 7 shows these Rabbit-based subsystems designed into the BL2100.

Figure 7.  BL2100 Subsystems
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3.1  BL2100 Pinouts

The BL2100 pinouts are shown in Figure 8(a) and Figure 8(b).

Figure 8(a).  BL2100 Pinouts (screw-terminal headers)

NOTE: Screw-terminal header J2 and the associated analog I/O are not available on the 

BL2110 and the BL2130. 
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3.1.1  Headers and Screw Terminals

Standard BL2100 models are equipped with two 1 × 12 screw-terminal strips (J8 and J14), 
and two 1 × 14 screw-terminal strips (J5 and J11). The BL2100 and BL2110 also have the 
RJ-45 Ethernet jack and one 1 × 16 screw-terminal strip (J2).

There is provision on the circuit board to accommodate one of the following types of 
connectors instead of the screw-terminal strips.

• 2 × 17, 2 × 20, and 2 × 25 IDC headers with a pitch of 0.1".

• 1 × 17, 1 × 20, and 1 × 25 friction-lock connectors with a pitch of 0.1". The holes used 
by the friction-lock connectors are on the “outside” edges of the connector locations.

• 1 × 17, 1 × 20, and 1 × 25 bottom-mount sockets with a pitch of 0.1". The holes for the 
bottom-mount sockets are on the “outside” edges of the connector locations

The pinouts for these connectors are shown in Figure 8(b).

Figure 8(b).  BL2100 Pinouts (other 0.1" connectors)

NOTE: Header J1 and the associated analog I/O are not available on the BL2110 and the 

BL2130. 
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